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In das Minimalsystem aus den beiden ersten Anleitungen sollen zwei integrierte Logik-
analysatoren eingefiigt werden, einen zur Beobachtung der Programmabarbeitung auf dem
Prozessor und einen zweiten zur Untersuchung der Signalverldufe auf dem AXI-Bus. Das Test-
programm ist eine Schleife, in der der Wert einer Variablen hochgezdhlt und auf die LEDs
ausgegeben wird. Das erste Ziel wird sein, die wichtigsten Trace-Signale des Prozessors fiir
einen Schleifendurchlauf zu visualisieren. Zur Interpretation der Trace-Signale wird das disas-
semblierte Programm und der erste integrierte Logikanalysator benotigt. Es wird sich zeigen,
dass der Prozessor 10 der 25 Takte fiir die Abarbeitung der innersten Schleife allein fiir die
Ausgabe des Zihlwerts auf die LEDs bendétigt. Im zweiten Experiment wird mit dem zwei-
ten Logikanalysator untersucht, was an der Ausgabe an die LEDs so viel Zeit verbraucht. Im
abschliefsenden Versuch werden beide Logikanalysatoren miteinander gekoppelt, um die Zeit-
beziehungen zwischen den Trace-, AXI-Bus- und LED-Ausgabesignalen zu untersuchen.

1 Ubernahme der Beschreibung des Minimalsystems

Statt eines Neuentwurfs soll die Rechnerbeschreibung des bisherigen Minimalsystems aus der
mhs- und der ucf-Datei auf der Webseite erzeugt werden. Dazu miissen die beiden Dateien
»min_sys.mhs« und »min_sys.ucf« von der Web-Seite ins Download-Verzeichnis geladen wer-
den. EDK ist zu starten und »Create New Blank Project« auszuwéhlen (Abb. 1).

i > Xilinx Platform Studio (EDK_P.68d) - no project opened
 Fle Edit View Project Hardware Device Configuration Debug Simulation

ImedlpselEr|laalE@]ls =

; Create Mew Blank Project
5 Create a new XPS project without using the Base

System Builder

Abbildung 1: Erzeugen des neuen Hardware-Projekts

In dem sich 6ffnenden Fenster, Abb. 2, wird festgelegt, in welchem Ordner die Projektdatei
angelegt werden soll. Das sollte ein leerer Ordner sein, der sich unter » Browse, New« direkt
erzeugen ldsst. Der Typ des zu programmierenden Logikschaltkreises (spartan6, xc6slx16, ...)
und das zu importierende mhs-File sind auszuwéhlen. Alle anderen Eintrige bleiben leer. Besté-
tigung mit » OK«.

Die zu iibernehmende ucf-Datei »..\Download\min sys.ucf« kann in das Projektunter-
verzeichnis »...\data« kopiert und in der Projektbaumansicht, Abb. 3, mit »Rechtsklick >
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—MNew project

Project file | H:\Softprozessor\BaselLA\system.xmp Browse ...

—Target device

Architecture Device Size Package Speed Grade

Ispar‘tanﬁ j Ixcﬁslxlﬁ j ICSQ324 j I'2 j

—Advanced options

¥ Import Design File (.mhs) from existing Project

IC:'\Userskgkemni‘aanwnIoads\min_sys.mhs Browse ...

™ Set Project Peripheral Repository Search Path

™ Set Custom Make File(instead of XPS generated MakeFile)

Auto Instantiate Clock/Reset
|7 ™ AXI Clock Generator ™ AXIReset Module

OK | Cancel Help

Abbildung 2: Festlegung des Pfads fiir das Software-Projekt

Change« gegen die automatisch erzeugte »system.ucf« ausgetauscht werden. Die Alternative

ist, beide ucf-Dateien im Editor zu 6ffnen und den Inhalt riiberzukopieren.

Froject + 08 X

Platform | il
= Project Files

- MHS File: system.mhs

UCF File: \\home\gkemnitz\Softprozessor\BasellLA\data\min_sys.ucf

- IMPACT Command Fie: etc/download.cmd

- Implementation Options File: etc/fast_runtime.opt _ILI
4

@ Project | & TP Catalog |

Abbildung 3: Ersatz der ucf-Datei

Mit den beschriebenen Schritten ldsst sich jeder Entwurf in einem neuen Projekt wieder-
herstellen, um Bausteine erweitern, mit » Run DRCs« kontrollieren, mit » Export Design« ab-

schlieften und nach SDK exportieren.

2 Konfiguration der integrierten Logikanalysatoren

Am einfachsten lassen sich die integrierten Logikanalysatoren in EDK mit dem Debug-Konfigurator

einfiigen. Der Debug-Konfigurator wird iiber das Menii:

Debug > Debug Configuration

gestartet. Im aufgehenden Fenster ist unten links » Add Chipscope Peripherial..« auszuwahlen.
Im n#chsten sich 6ffnenden Fenster, Abb. 4, gibt es drei Auswahlmoglichkeiten. Fiir die Beobach-
tung frei wihlbarer zu beobachtender Signale ist wie in Abb. 4 der mittlere Punkt vor »adding

ILA« auszuwéhlen und die Auswahl mit » OK« zu bestétigen.
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4% Add New ChipScope Peripheral x|

trigger/data in[0]

clk
" To monitor AXI Interconnect signals (adding AXI Monitor) :
+— triggeridata in[n]

* To monitor arbitrary system level signals (adding ILA)

S ChipScope sema ChipScope
" To provide JTAG-based virtual input/output (adding VIO) ILA ICON

Abbildung 4: Auswahl des Chipscope-Typs

Die Graphik im Fenster zeigt, wie ein integrierter Logikanalysator angeschlossen wird, zum
einen iiber einen Kontrollbus an den Controller »ICON«, der auch mit in das System eingebaut
werden muss, zum anderen an die zu beobachtenden Dateneinginge und den Abtasttakt. Die
abzutastenden Dateneingidnge konnen gleichzeitig Trigger-Eingénge sein, deren logische Werte
fiir den Aufzeichnungsbeginn mit ausgewertet werden. Der Takt wird bei uns der Systemtakt
sein.

Im néchsten Fenster, Abb. 5, werden unter dem Reiter » Basic« der Aufzeichnungstakt, die
Speichertiefe des Logikanalysator und die zu beobachtenden Signale ausgewéhlt. Links unter
» Available Ports on Instance« konnen die Bausteine des Rechnersystems und darunter die fiir
den Anschluss eines integrierten Logikanalysators verfiigbaren Ausginge ausgewihlt werden.
In Abb. 5 ist der Prozessor und vom Prozessor sind die Trace-Signale fiir den Befehlscode und
den Befehlszihlerstand des zuletzt fertig gestellten Befehls, das Giiltigkeitssignal fiir den Befehl
und das Signal, das anzeigt, ob die Datenspeicher-Pipeline lduft, ausgewahlt. Alle vier Signale
werden im Bild der Trigger-Gruppe » TRIG0« zugeordnet.

Basic | Advanced |

Available Ports on Instance: Signals Monitored by: -
I microblaze_0 j microblaze_0_Trace_Instruction_to_chipscope_ila_0
Trace_ICache_Req (Connected to Trace_ICache_Req) ﬂ Add >> | m?croblaze_D_Trace_MEM_PipeRun_to_;hipscope_ila_
Trace_Instruction (Connected to microblaze_0_Trace_Ir m!croblaze_D_Trace_PC._to_cmpscope._ua_D _
Trace_Jump_Hit (Connected to Trace_Jump_Hit) - < Remo'-.rel microblaze_0_Trace_Valid_Instr_to_chipscope_ila_0

Trace_Jump_Taken (Connected to Trace_Jump_Taken) LI

1;_]__ P N T P R P "'-'-I- Aeadinthacl) LI {I I LI

Select the number of signal samples you want: |1024 |

Select the clock to be used on monitoring: CLE -

Abbildung 5: Auswahl der an Trigger-Port 0 anzuschliefenden Trace-Signale

In Abb. 6 ist die Ausgabeeinheit und von ihr das Ausgabebyte an die LEDs ausgew#hlt, um
es mit Trigger-Eingang » TRIG1« zu verbinden. Trigger-Eintrag &ndern!

Im selben Menii unter » Advanced« gibt es eine Reihe weiterer Einstellungen (Abb. 7). » Use
the ILA Trigger Signals as Data Signals« bedeutet, dass die Signale an allen Trigger-Eingingen
aufgezeichnet werden. Fiir die beiden Trigger-Eingéinge ist nur die einfachste Funktionalitit
eingestellt: » Basic« (Zustands-Triggerung), nur eine »Match Unit«, kein Z&hler, d.h. Aufzeich-
nungsbeginn mit oder vor dem ersten Trigger-Ereignis. » Enable Trigger Out Signal ..« bedeutet,
dass das Trigger-Signal herausgefiihrt und an weitere integrierte Logikanalysatoren als Trigger-
Eingang verwendet werden kann. So ist es moglich, fiir mehrere integrierte Logikanalysatoren
die Aufzeichnungen zeitlich am selben Trigger-Ereignis auszurichten.

Nach Tatigung aller Einstellungen fiir den ersten integrierten Logikanalysator soll unten
links mit dem Button » Add Chipscope Peripherial..« ein weiterer Logikanalysator hinzugefiigt
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Basic | Advanced |

Any signals within the system can be monitored by ChipScope ILA (Integrated Logic Analyzer).
Available Ports on Instance: Signals Monitored by: I vI
|axi_gpin_l:| j Add == | Led

GPIO_IO_O (Connected to Led)

GPIO_IO_T i REIﬂD"-’El

Select the number of signal samples you want: |1024 vl
Select the clock to be used on monitoring: CLE -

Abbildung 6: Auswahl der an Trigger-Port 1 anzuschliefenden Ausgabesignale

System | Basic  Advanced |

= & Monitor Hardware Signals

~~ chipscope_ila_0 = Misc B

= Debug Software Application

‘- microblaze_0 Number of Data Samples Captured Per Trigger Match |1024 'I

= Miscellaneous Use The ILA Trigger Signal As The ILA Data Signal v

~ JTAG UART Enable The Trigger Out Signal "trig_out" v

Disable RPM Placement Infomation in Netlist r
Trigger on Rising Clock Edge T

Maximum Number of Levels supported by the Trigger Sequencer |1 3:
Enable Storage Qualification for ILA storage v

= Trigger Unit
Number of Match Unit Enabled for Trigger Unit 0 1 =
width of Trigger Input for Trigger Unit 0 Iﬂ
Match Counter Width for Trigger Unit 0 1] z
Match Type for Trigger Unit 0 basic j
Number of Match Unit Enabled for Trigger Unit 1 1 :
width of Trigger Input for Trigger Unit 1 8 =
Match Counter Width for Trigger Unit 1 0 s
Match Type for Trigger Unit 1 basic j
Number of Match Unit Enabled for Trigger Unit 2 0 s

Abbildung 7: Zusétzliche Einstellungen fiir den ersten Logikanalysator

werden. Auf dem sich 6ffnenden Fenster, Abb. 8, soll dieses mal » AXI-Monitor« ausgewihlt
werden. Der AXI-Monitor hat eine Schnittstelle fiir den AXI-Bus, optionale Trigger-Ein- und
Ausginge und verwendet den AXI-Takt fiir die Aufzeichnung.

In dem Fenster fiir die Grundeinstellungen, Abb. 9, ist nur der zu beobachtende AXI-Bus
und die Aufzeichnungstiefe auszuwéhlen. Ein zusétzlicher Haken bei » Hardware/Software Co-
debug« wiirde so Trigger-Einginge und -Ausgéinge des Logikanalysators mit Steuersignalen
des Debuggers verbinden, dass die Aufzeichnung des AXI-Monitors iiber die Haltepunkte des
Debuggers gesteuert werden kann. Das wird in diesem Beispiel jedoch nicht gebraucht.

Unter » Advanced /AXI Settings« wird der AXI-Bustyp ausgewihlt. Darunter unter »ILA-
Settings« die Aufzeichnungstiefe und die Grundeinstellungen fiir den Trigger. Der AXI-Monitor
soll einen 9-Bit » Trigger Input Port« fiir die Verbindung mit dem Trigger-Ausgang des anderen
Logikanalysators und fiir die zusétzliche Aufzeichnung der LED-Ausgaben erhalten. Die » Gobal
Port Settings« sollen bleiben wie gezeigt, insbesondere »Set number of match units for GLOBAL
port« gleich eins. Denn der unter »ILA Settings« konfigurierte » Trigger Input Port« gehort zu
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&+ To monitor AXI Interconnect signals (adding AXI Monitor) Interconnect

ACjILOLL

" To monitor arbitrary system level signals (adding I1LA)

trigger in
-y Ao lonitor P oour § ChipScope
trigger out COriro ICOM

" To provide ITAG-based virtual input/output (adding VI0)

Abbildung 8: Auswahl eines AXI-Monitors

System | Basic | Advanced |

E| @ Monitor Hardware Signals
: i  axi_monitor 0

—Manitor Bus Signals

chlpscope ila_0 Please select the bus that you want to monitor: |microblaze 0.M AXI DP j
ebug Software Application
‘.. microblaze 0 - Enable Hardware/Software Co-debug
= Miscellaneous Target Processar: =l
- JTAG UART
Select the number of signal samples you want to collect: |1024 vI

Abbildung 9: Grundeinstellungen des AXI-Monitors

dieser Gruppe.

Basic Advanced |

= AXI Settings

Select bus interface AXI4 Memory Map +|
= ILA Settings

Select the maximum number of samples stored by the |1024

ChipScope AXI Monitor

Select the number of sequence levels 1

Enable Trigger Input port

Set trigger input port width

]

?|<-

= Global Port Settings

i

Set number of match units for GLOBAL port

Set GLOBAL port match type [pasic with edges
Set GLOBAL counter width

e

Abbildung 10: Erweiterte Einstellungen des AXI-Monitors

Der AXI-Bus besteht aus fiinf dhnlichen Teilbussen: » Write Data Port«, » Write Adress
Port«, »Read Data Port«, »Read Adress Port« und » Write Response Port«. Jeder dieser Busse
bestehen wiederum aus Daten- bzw- Adressleitungen, Steuerleitungen und optionalen (in un-
serem Entwurf nicht vorhandenen) anwendungsspezifischen Leitungen. Unser Rechnersystem

hat nur eine Ausgabeschnittstelle, so dass nur die Leitungen fiir die Schreiboperationen ge-
braucht werden:

e vom Bus » Write Data Port« die Signale » WDATA« und » WDATACONTROL«
e vom Bus »Write Adress Port« die Signale » WADDR« und » AWADDRCONTROL« und

e vom Bus » Write Response Port das Signal » BRESP«.
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Fiir diese drei Signalgruppen sind jeweils »number of match units« auf »1« zu belassen und
fiir die iibrigen auf »0« zu setzen. Abb. 11 zeigt die Einstellungen beispielhaft fiir die beiden
Datenbusse. » AXT Stream Ports« und der » Protocol Checker« sind nicht verfiighar bzw. bleiben
deaktiviert.

System | Basic Advanced |
=@ Monitor Hardware Signals -
.~ chipscope_axi_monitor_0 '+ AXI Settings
- chipscope_ila_0

+ ILA Settings

E

ebug Software Application
.~ microblaze_0 + Global Port Settings
= Miscellaneous
L JTAG UART = Write Data Port Settings
Set number of match units for WDATA port |1 vI
Trace/Store WDATA signals Istore j
Set WDATA port match type [extended with edges |
Set WDATA counter width | 1 32
Set number of match units for WDATACONTROL port |1 'I
Trace/Store WDATACONTROL signals IStore j
Set WDATACONTROL port match type |basic with edges j
Set WDATACONTROL counter width | 1 3:

Set number of match units for WUSER port I[J vI

+ Write Address Port Settings
+ Read Data Port Settings

Set number of match units for RDATA port IU vI I__

Set number of match units for RODATACONTROL port IU 'I

Set number of match units for RUSER port IU vI

+ Read Address Port Settings
+ Write Response Port Settings

+ AXI Streaming Port Settings

+ Protocol Checker Settings

Abbildung 11: Erweiterte Einstellungen des AXI-Monitors

Im Fenster fiir die Debug-Konfiguration ldsst sich weiterhin fiir den Debugger einstellen,
wie viele Trigger-Einheiten er fiir Befehlsadressen (hardware breakpoints), Leseadressen (read
address watch points) und Schreibadressen (write address watch points) haben soll (Abb. 12).
Hier soll nichts gedndert werden. Die JTAG UART im Systemhaus darunter soll auch aktiviert
bleiben. Die gesamte » Debug Configuration« ist mit » OK« zu beenden!.

Abb. 13 zeigt das Gesamtergebnis. Der erste Logikanalysator hat zwei » Match Units«. An
» TRIGO« sind die Trace-Signale des Prozessors, an » TRIG1« die LED-Signale und als Abtast-
takt ist der 100MHz-Takt der Baugruppe angeschlossen. Die Steuerung und PC-Kommunikation
erfolgt {iber den Logikanalysator-Controller »ICON«, Steuer-Port » CTRL0«. Ein Trigger-Aus-
gang ist vorhaben, aber noch nirgends angeschlossen. Der zweite Logikanalysator ist als AXI-

!Die »Debug Configuration« kann nach dem SchlieRen wieder zur weiteren Bearbeitung getffnet werden.
Das System speichert jedoch dann gewisse nachtriigliche Anderungen nicht. Das ist daran erkennbar, dass
sie beim wiederholten Offnen nicht mehr da sind. Mdgliche Workarounds sind, den betroffenen integrierten
Logikanalysator zu 16schen, neu anzulegen und komplett neu zu konfigurieren oder die Korrekturen direkt im
mhs-File vorzunehmen.
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System | ¥ Enable software debugging for this processor
=8 Monitor Hardware Signals : -
L L chi pe_axi_monitor... Number of hardware breakpoints: |1 3
¢ chipscope_ila_0 Mumber of read address watchpoints: |D 32
= [?EDU Softwar Appiication Number of write address watchpoints: | 0 3
=+ Miscellaneous
- JTAG UART

Interconnect

Abbildung 12: Konfiguration des Debuggers

Monitor konfiguriert. Am ersten Trigger-Port sind die globalen Signale, insbesondere der 9-Bit-
Bus » TRIG _IN« angeschlossen. Am Trigger-Port fiir den AXI-Datenbus fiir Schreiboperatio-
nen ist auker den Daten ein Giiltigkeits- und ein Bestétigungssignal angeschlossen. Ahnliches
gilt fiir den AXI-Adressbus. Von dem Bestatigungsbus fiir Schreiboperationen soll im weiteren
nur das Giiltigkeitssignal interessieren, obwohl hier auch noch weitere Signale angeschlossen
sind. Der Aufzeichnungstakt ist der AXI-Bustakt, der im Beispielentwurf gleichfalls der 100MHz-
Baugruppentakt ist. Die Ansteuerung und PC-Kommunikation erfolgt iiber den Logikanalysator-
Controller »ICON«, Steuer-Port »CTRL1«.

Trace_Instruction 32

TLAO ; Global | AXI-
Trace_PC 32 (E TRIG.IN $ Port | Monitor
Trace_Valid_Instr g TRIG.OUTI—- AXI.WDATA 3 )
Trace MEM_PipeRun | _ AXI_AWREADY g:ttae
GPIO.I10.0 % AXI_AWVALID Port
S AXI_AWADDR 32 -
100 MHz Takt AXT_ WVALID Write
Adress
[LIRL AXI.WREADY Port
—— TDI : Write
mdm [ w77 ICON AXI_BVALID Response
(Debug- odate Port
Modul) |—2< CTRLOH 100 MHz —
TDO CTRLI CTRL

Abbildung 13: Gesamtbeschaltung der eingefiigten Logikanalysatoren
Die in Abb. 13 rot eingezeichneten Verbindungen
e »TRIG _OUT« von »ILA1« und die LED-Signale an » TRIG _IN« des AXI-Monitors und
e die Boundary-Scan-Verbindungen vom »mdm« zum »ICON«

fehlen noch und sind, wie im Folgeabschnitt beschrieben wird, manuell im mhs-File zu ergénzen.
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3 Erganzung der fehlenden Verbindungen

Ein »Design Rule Check« nach Schliefsen des Debug-Konfigurators mit » Run DRCs« liefert die
Warnungen in Abb. 14. Die ersten sieben Warnungen besagen, dass am »ICON« die Boundary-
Scan Anschliisse fehlen. Die unteren beiden Warnungen, dass zwei der an den AXI-Monitor
angeschlossen Signale nicht existieren und statt dessen Nullen aufgezeichnet werden, weisen auf
eine Unschonheit, aber kein wirkliches Problem hin.

Warnings

G: PORT: tdi in, CONNECTOR: bscan tdi - No driver found.

: PORT: reset in, CONNECTOR: bscan reset - No driver found.

: PORT: shift in, CONNECTOR: bscan shift - No driver found.

: PORT: update in, CONNECTOR: bscan update - No driver found.

: PORT: sel in, CONNECTOR: bscan sell - No driver found.

: PORT: drck in, CONNECTOR: bscan drckl - No driver found.

: PORT: capture in, CONNECTOR: bscan capture - No driver found.

: PORT: MON AXI AWREGION, CONNECTCR: mb(0 axi 5 AWREGICON - No driver found.
s: PORT: MCON RXI ARREGICN, CONNECTOR: mb0 axi S ARREGION - No driver found.

L
L
L
L
L
LaVy)
L
_:_

Abbildung 14: Warnungen des »Design Rule Checks« nach Einfiigen der Logikanalysatoren

Boundary-Scan ist ein serieller Testbus zur Kommunikation eines Diagnoserechners mit
Schaltkreisen einer Baugruppe und in unserem FPGA mit den einzelnen Diagnose- und Pro-
grammiereinheiten des Schaltkreises. Ohne Boundary-Scan-Anbindung ist der »ICON « und sind
die integrierten Logikanalysatoren nicht vom Arbeitsplatzrechner aus ansteuerbar. In einem in-
tegrierten Rechnersystem mit Debugger-Modul »mdm«, wie in unserem Beispiel, erfolgt der
Boundary-Scan-Anschluss iiber dieses, das entsprechend konfiguriert werden muss. Das Kon-
figurationsfenster ist zu 6ffnen und unter » Advanced« fiir »BSCAN location« wie in Abb.
15 »ICON« auszuwihlen. Alternativ kann auch im mhs-File fiir den »mdm« »PARAMETER
C_USE_BSCAN = 1« erginzt werden.

User | System | Interconnect Settings for BUS]Fl ﬂlﬂg

= Debug
Number of MicroBlaze debug ports m
-1 bscan_tdol & UART
MBDEBUG_O Enable JTAG UART ~
Specifies the Bus Interface for the JTAG UART IA}{I—LI
= Advanced
Specifies the JTAG user-defined register used Im
Select BSCAN location [1con 7]

Abbildung 15: Grundeinstellungen des AXI-Monitors

Die fehlenden Verbindungen zwischen Debug-Modul »mdm« und dem Logikanalysator-
Controller »chipscope icon« sind im mhs-File, wie in Abb. 16 gezeigt, zu ergéinzen. Fehler bei
den Port-Namen fiihren dazu, dass sich die » Assembly View« bis zu deren Beseitigung nicht
mehr Offnen ldsst. Nach Speichern des mhs-Files und wiederholtem Aufruf von » Run DRCs«
diirfen keine sich auf Boundary-Scan- (BScan-) Anschliisse beziehende Warnungen mehr er-
scheinen.
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90 BEGIN mdm 151 BEGIN chipscope icon
91 PAREMETER INSTANCE =debug module y55  paRAMETER INSTANCE =chipscope icon 0
103 ¥ erganzte BScan-Verbindungen 157 # ergdnzte BScan-Verbindungen
104 FORT bscan tdi = v_tdi 158 PORT tdi in = v_tdi
105 PORT bscan_reset = v_reset 159 PORT reset_in = v_reset
106 FORT bscan shift = v _shift 160 PORT shift in = v_shift
107 PORT bscan update = v _update 161 PORT update_in = v_update
108 PCORT bscan capture = v _capture 1g2 PORT capture in = v_capture
109 PORT bscan sell = v _sell 162 PORT sel_in = v_sell
110 PORT bscan drckl = v _drckl 164 PORT drck_in = v_drckl
111 PORT bscan tdol = v_tdo 165 PORT tdo out = v_tdo
112 END 166 END

Abbildung 16: Erginzung der BScan-Verbindungen im mhs-File

Zur Verbindung des Trigger-Ausgangs vom »chipscope ila« und dem LED-Ausgabeport
vaxi_ gpio« mit dem 9-bit Trigger-Eingang » TRIG _IN« des AXI-Monitors wird im mbhs-File
in Abb. 17

e in Zeile 119 ein Signal »Led _intern« an den Ausgang »GPIO 10 O« des LED-Ausgabeport
yaxi_gpio« und

e in Zeile 16 an den Ausgang »Led« der Gesamtschaltung angeschlossen.

e In Zeile 143 wird an den Trigger-Ausgang » TRIG _OUT« des ersten Logikanalysators
»chipscope ila« ein Signal »ILA0_TRIG_OUT« und

e in Zeile 177 wird an den 9 bit breiten Trigger-Eingang des AXI-Monitors die Konkatena-
tion des Trigger-Signals »ILAO0_TRIG _OUT« und des internen LED-Signals »Led _intern«
angeschlossen.

1§ PORT Led = Led intern, DIR = C, VEC = [7:0]
lil BEGIN axi gpio

119 | PORT GPIO IO O = Led intern

1%0 END

1é1 BEGIN chipscope ila

143 PORT TRIG OUT = ILAO TRIG OUT
144 END
163 BEGIN chipscope axi monitor

177 PORT MON AXI TRIG IN = ILA0 TRIG OUT & Led intern
178 END

Abbildung 17: Eintrage im mhs-File zur Verbindung des Trigger-Eingangs des AXI-Monitors
mit dem Trigger-Ausgang des ersten Logikanalysators und den LED-Signalen

4 FErstellen und Test eines Beispielprogramms

Der Hardware-Entwurf kann mit den Dateien »system.bit«, »system.xml« und »system db.bmm«
auf der Web-Seite in der Tabellenzeile zu diesem Projekt wie in Anleitung » Debugger«, Ab-
schn. 2 iibersprungen werden. Egal, ob die Hardware-Beschreibung selbst erstellt oder von der
Web-Seite iibernommen wurde, sind in SDK wie in den ersten beiden Anleitungen beschrieben
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e cin »Board Support Packagex,
e cin leeres » Application Project« (der Name sei diesmal »CS_Test«) und
e cine C-Quelldatei (der Name sei diesmal »cst_main.c«)

anzulegen. In die C-Quelldatei ist das Programm in Abb. 18 einzugeben bzw. aus der entsprechen-
den Datei auf der Web-Seite in die Datei zu kopieren?.

5 Project 22 =8 #include <xparameters.h>
S &| ¥~ #:i.nclude <x1o.h>.
#include <xuartlite_1.h>

int b‘nain(){

13 BasellA_hw_platfor
B2 CS_Test

%‘* f-ln?n;s char *str = "Starte Testschleife:\r\n";
e -~ while (*str 1= 0) {
& Debug XUartLite_SendByte(XPAR_UARTLITE_@_ BASEADDR, *str);
E@ 5re : str++;
B [€] cst_main.c }
-8 Iscript.id
T lscrip u8 dat;
------ |=| README.txt hile (1){
-l standalone_bsp_0 while

for (dat=0;dat<0xF8;dat++){
XIo_Out8(XPAR_GPIO © BASEADDR, dat);

¥

XIo_Out8(XPAR_GPIO_© BASEADDR+0x1@, BxFB);

) XIo_Out8(XPAR_GPIO_© BASEADDR+0x10000, ©xFD);

}

Abbildung 18: Beispielprogramm zum Ausprobieren der integrierten Logikanalysatoren

Das Beispielprogramm gibt einen Text aus, zdhlt in einer For-Schleife den Ausgabewert fiir
die LEDs von 0 bis 0xF7 hoch. In der duferen Endlosschleife wird zwischen der Ausgabe von
0xF7 und 0x00 auf die Adresse des Ausgaberegisters, der Wert 0xFB auf eine um zehn héhere
Adresse (d.h. einer Adresse, die im Adressbereich der Ausgabeschnittstelle liegt) und der Wert
0xFD auf eine um 0x1000 hohere Adresse auferhalb des Adressbereichs der Ausgabeschnittstelle
ausgegeben?®.

Nach Anlegen des Gesamtprojekts, der Programmeingabe und der Beseitigung eventueller
Fehler erfolgt die Inbetriebnahme und der Programmstart mit denselben Schritten wie in der
Anleitung » Minimalsystem«, Abschn. 4 (Software-Entwurf):

e Programmierung der Hardware-Funktion:
Xilinx Tools > Program FPGA

e Einrichten der » Run Configuration«Falls nicht automatisch erfolgt:
Run > Run Configuration

Dabei ist wieder unter »STDIO Connection« der Haken bei » Connect STDIO to Console«
zu setzen und »JTAG UART« auszuwéhlen.

e und starten des Programms mit » Run« bzw. iiber die Schaltfliche @.

’Die C-Quelldatei kann auch von der Web-Seiter heruntergeladen, in den Projektordner kopiert und dann in
das Projekt eingebunden werden.

3Die beiden Ausgaben auf andere Adressen dienen dazu, bestimmte Eigenarten des AXI-Busses und der
Ausgabeschnittstelle zu demonstrieren.
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Nach dem Start erscheint auf der Konsole die Ausgabe »Starte Testschleife:«. Danach geht das
Programm in die Endlosschleife, deren Signalverldufe zu untersuchen sind. Die Ausgabe zahlt
dabei so schnell hoch, dass alle acht Leuchtdioden (LEDs) dauerhaft leuchten.

5 Disassemblieren der LED-Ausgabeschleife

Zur Untersuchung und Auswertung der Signalverlaufe im Rechner wird das disassemblierte
Programm benétigt. Am einfachsten ist das disassemblierte Programm im Debugger einsehbar.
Dazu ist die Programmabarbeitung mit dem Debugger zu starten:

Debug > Debug

(oder F11 oder einen Klick auf das Kéfersymbol %#). Die moglichweise gestellten Fragen »...
terminate previos launch?« und »... switch perspective?« sind wieder mit » Yes« zu beantworten.
Nach dem Wechsel in die Debug-Ansicht ist das Fenster mit dem disassemblierten Text zu
Offnen:

Windows > Show view > Disassembly

Abb. 19 zeigt den disassembliert Programmausschnitt mit der Ausgabeschleife an die LEDs.

ARERBG3C: sbi r@, ri19, 32
00000640 : bri 32 // @x660 <main+136>
a2d XIo Out8(XPAR_GPIO ©® BASEADDR, dat);
00000644 imm 16384
0000648 : addik r3, r@, 0 // 0x40000000
ARERB64C: lbui r4, r19, 32
BP000B650: sbi rd, r3, @
» 23 for (dat=0;dat<0xF8;dat++){
00000654 : lbui r3, r19, 32
BPO0B658: addik r3, r3, 1
ARERBG65C: sbi r3, ri19, 32
BPO0R660 : lbui r4, ri19, 32
ARERB664 addik r3, r@, 247 [/ 8xf7 < do global dtors aux+115>
PR0eBL6HE : cmpu rl8, rd, r3
BPO00B66C: bgei r18, -40 [/ 8x644 <main+108>

26 XIo_Out8(XPAR_GPIO_© BASEADDR+0x1@, OxFB);
000P0670:  imm 16384
00000674:  addik r3, re@, 16 // 0x40000010

0ePRB67S: addik r4, r@, -5

ARERBGTC: sbi rd, r3, @

27 XIo Out8(XPAR_GPIO @ BASEADDR+0x10000, @xFD);
0ePRB630: imm 16385

000RE6S4: addik r3, r@, @ // 9x40010000

0OPRB6SS: addik r4, r@, -3

APERBG6SC: sbi rd, r3, @

28 ¥

0e0RB690: bri -84 // @x63c <main+100>

Abbildung 19: Disassembliertes Programm in der Debug-Ansicht

Die Befehlsfolge von Adresse 0x644 bis 0x650 schreibt den Wert der Variablen »dat« auf die
Ausgabeschnittstelle (Adresse 0x40000000). Die Befehle von 0x654 bis 0x658 erhéhen den Wert
von »dat« um eins. Die weitere Befehlsfolge bis zur Adresse 0x66C liest den Wert von »dat«,
vergleicht ihn mit 247 (0xf7) und springt, solange er kleiner ist, zum Schleifenanfang (Adresse
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0x644). Die Befehlsfolgen auf den Adressen 0x670 bis 0x67C bzw. von 0x680 bis 0x68c¢ geben
die Konstanten 0xEFB (-5) bzw. 0xFD (-3) auf die Adressen 0x4000010 bzw. 0x4001000 aus. Der
Befehl auf Adresse 0x690 ist der Riicksprung am Beginn der Endlosschleife.

Die Alternative zur Erzeugung des disassemblierten Programms ist ein Dump auf der Kom-
mandozeile. Dazu ist die XMD-Konsole zu &ffnen mit:

Xilinx Tools > Launch Shell

Auf der Konsole ist mit »cd« in das Verzeichnis mit dem elf-File* zu wechseln, das sich im
Debug-Unterverzeichnis des Software-Projekts befindet. Der Verzeichnisinhalt 1dsst sich mit
»ls« einsehen. Die nachfolgende Kommandozeilenanweisung disassembliert und schreibt das
Ergebnis in eine Textdatei »cst_main.asm« (vergl. Abb. 20):

mb-objdump -d HalloWelt.elf > cst-main.asm

C:\Windows\system32\cmd.exe

H:=“5of tprozessor~SW_BaseILA~CS_Test Debug>ls
C5_Test_elf % _Test.elf _size obhjectz.mk src
CS_Test.elf.elfcheck makefile sources .mk

H:“Sof tprozessor SW_BaseILANCS _Tests\Debugmb—objdump —d C8_Test.elf > disass.txt

H:~Softprozessor SW_Base ILANCS _Test Debug>

Abbildung 20: Erzeugen eines Objekt-Dumps auf der XMD-Konsole

Der interessante Bereich ist identisch mit dem aus Abb. 19. Nur die Zwischenzeilen mit
den Hochsprachenanweisungen fehlen. Dafiir enthilt das so erzeugte Assemblerprogramm die
Befehlsworte, die zum Debuggen mit einem Logikanalysator benotigt werden.

Adresse Befehlswort Assemblerbefehl // realisierte Funktion

0x63c: 0x£0130020 sbi r0, r19, 32

0x640:  0xb8000020  bri 32 // springe zu Adresse 0x660
0x644: 0xb0004000 imm 16384 // mem(0x4000000) := dat
0x648: 0x30600000  addik r3, r0, O

O0x64c: 0xe0930020  1bui r4, ri19, 32

0x650: 0xf0830000 sbi r4, r3, O

0x654: 0xe0730020  1lbui r3, rl9, 32 // dat := dat+l

0x658: 0x30630001 addik r3, r3, 1

0x65c: 0xf0730020 sbi r3, r1l9, 32

0x660: 0xe0930020 1lbui r4, ri19, 32 // wenn dat>0xf7 dann
0x664:  0x306000f7 addik r3, r0, 247// springe 40 Bytes

0x668:  0x16441803 cmpu rl8, r4, r3 // =zuriick zu Adresse 0x644
0x66¢: Oxbcb2ffd8  bgei ri18, -40

0x670: 0xb0004000 imm 16384 // mem(0x4000010) := dat
0x674: 0x30600010  addik r3, r0, 16

0x678: 0x3080fffb  addik r4, r0, -5

0x67c: 0xf0830000 sbi r4, r3, O

0x680: 0xb0004001 imm 16385 // mem(0x4001000) := dat
0x684: 0x30600000  addik r3, r0, O

0x688: 0x3080fffd  addik r4, r0, -3

0x68c: 0xf0830000 sbi r4, r3, O

0x690:  0xb800ffac bri -84 // springe zu Adresse 0x63c

Abbildung 21: Mit »mb-objdump« disassembliertes Programm

4ELF (Executable and Linkable Format) — Dateiformat fiir ausfiihrbare Programme.
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6 Untersuchung der Abarbeitung der innersten Schleife

Fiir die nachfolgenden Experimente ist das Programm in SDK mit » Run« (d.h. ohne Debugger)
zu starten. Nachdem das Programm sich auf der Konsole mit »Starte Testscheife:« gemeldet
hat, ist die Logikanalysator-Software zu starten. Das erfolgt iiber » All Programms« und dann
weiter wie in Abb. 22 a. Es muss die 64-Bit-Version der Logikanalysator-Software sein.

¥ilinx Design Tools
ISE Design Suite 14.6

i File View JTAG Chain Window Help
Accessories
ChipScope Pro = q
ChipScope 32-bit New Prolgct g
ChipScope 64-bit JTAG Chain :
2N Analyzer
(=
pﬁa’: Core Inserter (a (b

Abbildung 22: a) Start des Chipscope-Analyzers b) Das sich 6ffnende Fenster

Nach einem Klick auf das Icon %= in Abb. 22b oben links werden alle Schaltkreise der
JTAG-Kette angezeigt. Auf unserem Board ist es nur der eine FPGA (Abb. 23).

ChipScope Pro x|
JTAG Chain Device Order
Index Mame Device Name IR Length | Device IDCODE | USERCODE
0{MyDevicel KCBSLX16 G 44002093
| Ok | ‘ Cancel ‘ ‘ Read USERCODEs ‘

Abbildung 23: Erkannter Schaltkreis am JTAG-Bus

Nach Auswahl mit »OK« werden links im Projektfenster, Abb. 24, die gefunden integri-
erten Logikanalysatoren des ausgewihlten Schaltkreises angezeigt. Im Beispiel ist » MyILAO«
der Logikanalysator fiir die Trace-Signale und » MyILAl« der Logikanalysator fiir den AXI-
Bus. Rechts im Bild ist die Oberflache fiir die Trigger-Einstellungen » Trigger Setup« des ersten
integrierten Logikanalysators dargestellt. Die initiale Einstellung im Bild, Match-Wert alles
»X« (ohne Bedeutung) und Trigger wenn »MO« aktiv ist, bedeutet, dass nach einem Klick
auf den Aufzeichnungs-Button » die Aufzeichnung sofort beginnt. Unter dem Fenster fiir die
Trigger-Einstellung werden die (hier ab einem zufélligen Startzeitpunkt) aufgezeichneten Sig-
nale dargestellt.

Fiir die Auswertung der Aufzeichnungsergebnisse ist es zweckmifig, alle Signale so umzube-
nennen, wie sie in der Schaltung heiffen, und die Einzelbits genau wie in der Hardware-Be-
schreibung zu Bitvektoren zusammenzufassen. Der Debug-Konfigurator fiir die integrierten
Logikanalysatoren im EDK hinterlegt hierfiir im Unterordner »implementation« des Hardware-
Projekts im Wrapper-Verzeichnis eines jeden integrierten Logikanalysators eine cdc-Datei, die
mit

File > Import

einzulesen ist. Abb. 25 zeigt die Auswahleintrige fiir die cdc-Dateien beider Logikanalysatoren.
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@ | Troserrunoce [Snas[v]| b m T 2| % S 9 ¢ 2 2R

New Project &1 Trigger Setup - DEV:0 MyDeviced {(XC6SLX16) UNIT:0 MylLAO (ILA)
JTAG Chain M i . :
¢ DEV-0 MyDevice0 (XCESLX16) = M.atc.h Unit Fun_u:imn Value Ra.dlx Counter
o UNIT-0 MylLAD (ILA} a:; o MO:TriggerPort == MO 000 3000000 0003000 Bin disabled
Trigger Setup o= W1:TriggerPort1 == OO0 000 Bin dis
WﬂVEfUI’I'TI -
Listing || Add |[Act..Trigger Condition Na... Trigger Condition Equation Qutput Ena..
Bus Plot &~ ® | TriggerConditiond Mo Disabled
¢ UNIT: 1 MylLAT (ILA) —
Trigger Setup -
Waveform Q Type: = Windows: 1| Depth: |[1024 Paosition: 0
Listing =
Bus Flot @ | Storage Qualification: All Data
Signals: DEV: 0 UNIT: 0 N 2} waveform - DEV:0 MyDevice0 {(XC6SLX16) UNIT:0 MylLAO {ILA) ; 1
o= Data Port ;
: . 0 410 1) 120 160 200 240 2380 32
o= Trigger Ports : Bus/Signal X 0} m I | | | | | | |
: DataPort[0] 1 1
DataPort[1] i 1

Abbildung 24: Projektbaum beider Logikanalysatoren sowie das Trigger- und das Waveform-
Fenster des ersten Logikanalysators mit den initialen Einstellungen

rimport File rimport File
File: chipscope_ila_0.cdc File: chipscope_axi_maonitor_0.cdc
Directory: ...\BaselLA\implementation\chipscope_ila_0_wrapper Directory: ... \implementation\chipscope_axi_monitor_0_wrapper
Select Mew File Select Mew File

rUnit/Device rUnitiDevice
[CEV:0UNIT:O(LA)  [w] [DEV. OUNIT: 10LA)  [+]
Auto-create Buses Auto-create Buses
[ oKk |[ Cancel | [ oK |[ cCancel |

Abbildung 25: Import-Fenster fiir die cds-Dateien der beiden integrierten Logikanalysatoren

Um einen gewiinschten Signalverlaufsabschnitt aufzuzeichnen, ist eine geeignete Trigger-
Bedingung festzulegen. Im Fenster » Match« werden die Vergleichswerte fiir die Signale einge-
stellt, die zum Trigger-Zeitpunkt definierte Werte haben sollen, und im Fenster darunter die
Trigger-Bedingung als logische Verkniipfung von einem oder mehreren Vergleichsergebnissen.
Im Beispiel in Abb. 26 soll der Trigger beim erstmaligen Auftreten des LED-Ausgabewerts
OxF7 an »M1:TRIG1« ausgelost werden. Im Fenster » Capture« darunter ist zusétzlich fest-
gelegt, dass die Aufzeichnung acht Takte vor dem Trigger-Ereignis beginnen und 1024 Werte
umfassen soll. Nach einem erneuten und jedem weiteren Klick auf den Aufzeichungs-Button »
wird ein Signalverlauf aufgezeichnet, bei dem zum Zeitpunkt null (W) der Ausgabewert an den
LEDs, dem die cdc-Datei den Bezeichner » GPIO 10 O« gegeben hat, nach 0xF7 wechselt.
Das Fenster darunter zeigt die mit Zoom vergroferten Signalverlidufed.

Die innere Schleife umfasst nach Abb. 19 in Abschnitt 5 den Programmbereich 0x644

®Gelegentlich tritt der Fehler auf, dass der Logikanalysator fiir einige Samples verniinftige Werte und danach
nur noch Einsen aufzeichnet. Das tritt insbesondere auf, wenn nach Start des Logikanalysators das Programm
in SDK erneut gestartet wird. Der Workaround dazu ist, die Kabelverbindung zwischen der Chipscope-Software
auf dem PC und dem Schaltkreis mit

JTAG Chain [> Close Cable

zu schliefen, mit ®# erneut zu 6ffnen und die Aufzeichnung mit ® noch einmal zu starten. Die Trigger- und
andere Einstellungen bleiben dabei erhalten.
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@ Trigger Setup - DEV:0 MyDevice0 (XCG6SLX16) UNIT:0 MyILAD (ILA) B
= Match Unit Function Value Radix Counter
2| = I moTrRIGO == X_XH0CK 000K _I0CK_00EK Hex |
=

o= M1 TRIG == F7 Hex =
;‘| Add Active Trigger Condition Mame Trigger Condition Equation Qutput Enable
= ) TriggerConditiond M1 Disabled =l
@ Waveform - DEV:0 MyDevice0 (XC6SLX16) UNIT:0 MyILAO (ILA) :
i I 2 Fo12 1F 22 27 32 37 42 4AF B2 5HF 62 67 T2 77
Bus/Signal ST T P I N DO PN TN T D PUUTN DL PUUOY IO IO

% GPID IO O

o Trace PC

Trace MEM PipeRun

Trace Valid Instr

@ Trace Instruction

N

[ ]

[

-
S T [ S I I 1 S I 6 I

F& F7 I FE b on
I nanocang o o e brrrm ng(0MErE 00NN N nanocenz ¥ N0 0
T sze00000 0 00 Esnnnngn et 1e.. 0NN s2a00000 K 0N

Abbildung 26: Trigger-Einstellungen und aufgezeichnete Trace-Signalverlaufe

bis 0x670. Beim Vergleich mit den aufgezeichneten Befehlszéhlerwerten fillt auf, das die in
Abb. 26 dargestellten Werte bitgespiegelt sind. Ein Umkehrung der Bitreihung in Bussen er-
folgt mit Rechtsklick auf den Signalnamen und der Auswahl »Reverse Bus Order«. Auch fiir
»Trace Instruction« ist die Bitreihung umzukehren, damit die Befehlsworte denen in Abb. 21
entsprechen. Zur Visualisierung der nur einen Takt anliegenden Adressen und Befehlsworte ist
der Zoom zu vergréfern. Alternativ gibt es in Abb. 24 links unter Trigger und Wave auch
die Auswahl »Listing«, in der die aufgezeichneten Signalwerte tabellarisch dargestellt werden.
Abb. 27 zeigt das »Listing« fiir einen Durchlauf der innersten Schleife, beginnend und endend
mit einem Sprung zur Adresse 0x604. Ausgewahlt wurde dafiir der mit dem 100-sten Aufzeich-
nungswert beginnende Durchlauf, in dem sich der Ausgabewert von 0x01 auf 0x02 erhdht.

Sample [Valid Instr | Trace PC |Instruction| GPIO IO O |MEM Pipe
100 ] 00000&70 BOOO4000 01 1
101 1 00000644 BOOO4000 01 1
102 1 00000648 30600000 01 1
103 1 0000064C EQS30020 01 1
104 0 0000064C E0S30020 01 1
105 ] 00000&64C E0930020 01 ]
104 ] 00000&64C E0930020 01 ]
107 0 0000064C EN930020 01 0
108 0 0000064C E0S30020 01 0
1049 0 0000064C EQS30020 01 0
110 ] 00000&64C E0930020 02 ]
111 ] 00000&64C E0930020 02 ]
112 ] 00000&64C E0930020 02 ]
113 0 0000064C EQS30020 02 1
114 1 00000650 FOE30000 o2 1
115 1 00000654 EQT730020 a2 1
114 ] 00000654 EQ730020 02 1
117 ] 00000654 EQ730020 02 1
118 1 00000658 30630001 o2 1
1149 1 0000065C FO730020 02 1
120 1 00000660 E0S30020 o2 1
121 1 00000664 306000F7 02 1
122 ] 00000664 306000F7 02 1
123 1 00000668 16441803 02 1
124 1 00000660 BCB2FFDA o2 1
125 0 00000670 BOOO4000 02 1
124 ] 00000&70 BOOO4000 02 1
127 1 00000644 BOOO4000 02 1

imm 0x400
addik r3, r0, O
lbui r4, r19, 32

sbi r4, r3, 0
lbui r3, r19, 32

addik r3, r3, 1
sbi r3, r19, 32
lbui r4, r19, 32
addik r3, r0, OxF7

cmpu ri18, r4, r3
bgei r18, -40

Abbildung 27: Aufgezeichnete Trace-Signale als Listing
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Das Signal »Valid Instr« signalisiert mit einer »1«, dass die Adresse und das Befehlswort
in den nachfolgenden Spalten giiltig sind. Den giiltigen Befehlen wurden unter Verwendung
des disassemblierten Programms aus Abb. 21 Assemblernotationen zugeordnet. Zweierlei ist zu
erkennen:

e Die Adressen und Befehle stimmen mit denen aus Abb. 21 {iberein.

e Manche Befehle werden unmittelbar nacheinander abgearbeitet und zwischen manchen
gibt es Liicken.

Insbesondere die grofse Liicke von »Sample« 105 bis 112 féllt auf. Da in dieser Liicke auch das
Trace-Signal »MEM PipeRun« inaktiv ist, entsteht diese offenbar wihrend der Schreibopera-
tion auf den AXI-Bus. Das Befehlswort dafiir »sbi ..« (Speichere r4 als Bytewert auf die Adresse
r3-+0) erscheint aber im Trace erst nach der Ausgabe (Sample 114). Daraus ist ableitbar, dass
die Trace-Signale die Adressen und Befehlsworte der abgeschlossenen, und nicht der begonnen
oder gerade bearbeiteten Befehle widergeben. Anders sieht das bei dem Sprung am Schleifen-
ende aus. Nach dem abgeschlossen Sprungbefehl erscheint im Trace zweimal das Befehlswort
auf Adresse 0x670, d.h. das nach dem Sprungbefehl, das nicht auszufiihren ist. Das legt die
Vermutung nahe, dass die beiden ungenutzten Takte nach dem Sprungbefehl, in denen das
Signal »Valid Intr« inaktiv ist, zum Sprungbefehl gehoren.

7 Untersuchung der AXI-Bus-Signale

In diesem Abschnitt soll untersucht werden, ob es wirklich die Ausgabe an die LEDs ist, die fast
50% der Abarbeitungszeit der innersten Schleife benétigt. Dazu ist das Trigger- und Waveform-
Fenster des AXI-Monitors zu 6ffnen. Die Trigger-Bedingung sei dieselbe wie im ersten Versuch
(LED-Ausgabewert gleich 0xF7). In dem in Abb. 25b importierten cdc-File gibt es die LED-
Anschliisse noch nicht, sondern noch die neun ».. TRIG_IN« Anschliisse an »CH: 47« bis
»CH: 55«, die wie in Abb. 28b umzubenennen sind. Zusétzlich ist »CH: 55«, an dem der
Trigger-Ausgang des ersten Logikanalysators angeschlossen ist, mit Rechtsklick und » Remove
from Bus« in ein Einzelsignal umzuwandeln. Die selben Umbenennungen sind auch darunter
bei den Trigger-Ports nochmal erforderlich.
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¢ Data Port
&= microblaze_0.M_AXI_DP/MON_AXI_ARPROT

o=
o=
o=
¥

microblaze_0.M_AXl_DP/MON_AXI_AWADDR
microblaze_0.M_AXl_DP/MON_AXI_AWPROT
microblaze_0.M_AXl_DP/MON_AX]_BRESP
microblaze_0.M_AXl_DP/MON_AXI_TRIG_IN

CH: 47 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[O]
CH: 48 microblaze_0.M_AXI_DPIMOMN_AXI_TRIG_IN[1]
CH: 49 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[Z]
CH: 50 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[3]
CH: 51 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[4]
CH: 52 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[5]
CH: 53 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[E]
CH: 54 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[Y]
CH: 55 microblaze_0.M_AXI_DPIMOMN_AX]_TRIG_IN[8]

&= microblaze_0.M_AX]_DP/MON_AXI_WDATA
&= microblaze_0.M_AXI_DP/MON_AXI_WSTRB

CH:
CH:

CH

CH

CH

3 microblaze_0.M_AXl_DP/MON_AXI_ARREADY
4 microblaze_0.M_AX]_DP/MON_AXI_ARVALID

- 40 microblaze_0.M_AXI_DPIMON_AXI_AWREADY
CH:
CH:

41 microblaze_0.M_AXI_DPIMON_AX]_AWVALID
42 microblaze_0.M_AXI_DPIMON_AXI_BREADY

- 45 microblaze_0.M_AXI_DPIMON_AXI_BWALID
CH:
CH:

46 microblaze_0.M_AXI_DPIMOMN_AXI_ARESETM
88 microblaze_0.M_AXI_DPIMOMN_AX]_WREADY

83 microblaze_0.M_AXI_DPIMOMN_AXI_WWVALID al

¢ Data Port

o= microblaze_0.M_AXI_DP/MON_AXI_ARPROT
o= microblaze_0.M_AXI_DP/MOMN_AXI_AWADDR
o= microblaze_0.M_AXI_DP/MOMN_AXI_AWPROT
= microblaze_0.M_AXI_DP/MON_AX]_BRESP
¢ Led
CH: 47 Led[0]
CH: 48 Led[1]
CH: 49 Led[2]
CH: 50 Led[3]
CH: 51 Led[4]
CH: 52 Led[5]
CH: 53 Led][f]
CH: 54 Led[7]
o= microblaze_0.M_AXI_DP/MON_AXI_WDATA
¢ microblaze_0.M_AXI_DP/MON_AX]_WSTRB
CH: 3 microblaze_0.M_AXI_DPMON_AXI_ARREADY
CH: 4 microblaze_0.M_AXI_DPMON_AXI_ARVALID
CH: 40 microblaze_0.M_AXI_DPIMON_AX]_AWREADY
CH: 41 microblaze_0.M_AXI_DP/MON_AXI_AWWALID
CH: 42 microblaze_0.M_AXI_DP/MON_AXI_BREADY
CH: 45 microblaze_0.M_AXI_DPIMON_AXI_BVALID
CH: 46 microblaze_0.M_AXI_DPIMON_AXI_ARESETN
CH: 55 Triggerin
CH: 88 microblaze_0.M_AXI_DP/MON_AXI_WREADY
CH: 93 microblaze_0.M_AXI_DPIMON_AXI_WVALID

Abbildung 28: Umbenennung der Signale am Trigger-Eingang des AXI-Monitors

b)

17

Die LED-Signale, auf die getriggert werden soll, gehoren zur Match-Gruppe »M4:MON-
~AXI GLOBAL« (Abb. 29). Der Vergleichswert 0b11110111=0xF7 ist den mittleren acht
Bits zuzuordnen. Der Vergleichswert fiir die beiden anderen Bits ist » X« (beliebig). Aufzeich-
nungstiefe sei wie im ersten Versuch 1024 und Aufzeichnungsbeginn acht Takte vor dem Trigger-

Ereignis.

= Match Unit Function Value Radix Counter
21| o= M3MON_AXI_BRESP == WO Bin disabled
= ¢ M&MOMN_AXI_GLOBAL == [X1_1110_111X| Bin disabled

ILAD_TRIG_OUT X

Led[7] 1

Led][5] 1

Led[5] 1

Led[4] 1

Led[3] 0

Led[2] 1

Led[1] 1

Led[0] 1

microblaze_0.M_AXI_DP/MON_AXI_ARESETN X

o= MEMOMN AXl WDATA = SO X Hex disabled

_:J Add || Active| Trigger Condition Name Trigger Condition Equation Qutput Enable
allpa | ® TriggerCondition0 M4 Disabled
g Type: Windows: 1 Depth. Position: 8
E Storage Qualification:

Abbildung 29: Trigger-Einstellung fiir den AXI-Monitor

Nach der Trigger-Einstellung ist die Aufzeichnung mit » zu starten. Abb. 30 zeigt einen
Ausschnitt der aufgezeichneten Daten. Die nicht dargestellten Signale inkl. der hoherwertigen
24 Datenbits von »...  WDATA« wurden mit Rechtsklick und » Remove from Viewer« aus der
Darstellung entfernt.

Die Ausgabeadresse und die Ausgabedaten liegen bereits fiinf Takte vor der LED-Ausgabe
auf den entsprechenden AXI-Teilbussen an. Die Adresse wird durch »..  AWVALID« drei Takte
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o Led FE__ X F7 H FE H I
o ... _AXI_AWADDR | _ i 40000000 ¥ W OG0GO 20000010 Ck001000000 ol 0 X 20000000 ¥
ve. AXI RWVALID [ ] [ ] [ [ ]
.. MXT BWREADY [ [ [ [
o- ..._AXI WDATA F7 Con 3007 ¥oo0C__Fe 000 _Fo (00
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. +._REI_WVALID [ ] | | | -
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Abbildung 30: Aufgezeichnete AXI-Bussignale

fiir giiltig erklart. Das Adressgiiltigkeitssignal schaltet nach Aktivierung des Bestétigungssignals
».. AWREADY « ab. Das Giiltigkeitssignal fiir die Daten ».. WVALID« ist etwas ldnger aktiv
und schaltet gleichfalls nach der Aktivierung seines Bestitigungssignals, hier ».. WREADY«
ab. Die Bestitigung der Adresse erfolgt vor der Ausgabe an die LEDs, d.h. die Adresse bzw.
die Ausgabefreigabe muss noch irgendwo zwischengespeichert werden. Die Daten sind bis nach
der Ausgabe giiltig und miissen nicht zwischengespeichert werden. Die Ausgabe von 0xFB
auf die Adresse 0x40000010 verursacht denselben Zeitablauf und &ndert gleichfalls den LED-
Ausgabewert. Bei der Ausgabe auf die Adresse 0x4001000, die nicht zum Adressbereich der Aus-
gabeeinheit gehort, bleibt das Ausgaberegister unverdndert und das Bestitigungssignal kommt
friiher. Der AXI-Bus hat offenbar fiir die Ausgabe eines Bytes in ein Register ein recht kom-
pliziertes und zeitaufwindiges Protokoll.

8 Kopplung beider Logikanalysatoren

Als néchstes soll untersucht werden, wie die Trace-Signale des Prozessors und die AXI-Bus-
Signale zeitlich zueinander ausgerichtet sind. Dazu miissen beide Logikanalysatoren gleichzeitig
getriggert werden. Fiir den AXI-Monitor soll der Trigger wie in Abb. 31 so umgestellt werden,
dass die Aufzeichnung 8+10 Takte® vor Aktivierung des Trigger-Ausgabesignals des ersten
Logikanalysators beginnt.

é Match Unit Function Value Radix Counter
= o O MAMON_AX GLOBALl == |[1X_ 20002000 Bin disabled
o

[y 1so_TRIG_OUT 1

[ Led[7] X
5 Add |[Acti..| Trigger Condition Name | Trigger Condition Equation Qutput Enable
= ® | TriggerConditiond 14 Disabled
o =W U - . it mre
E Type: = Windows: 1| Depth: [1024 Pasition: 13
=
@ | Storage Qualification: All Data

Abbildung 31: Trigger-Einstellung des AXI-Monitors fiir die gekoppelte Aufzeichnung

Fiir den ersten Logikanalysator soll die Trigger-Bedingung das erste Auftreten des LED-
Werts 0xE7 bleiben. Nur der Trigger-Ausgang ist auf » Pulse (High) umzustellen (Abb. 32).

Zu Aufzeichnung ist zuerst das Trigger-Fenster des AXI-Monitors auszuwahlen und mit »
die Aufzeichnung fiir den AXI-Monitor zu starten. Dann ist das Trigger-Fenster des ersten

SDer AXI-Monitor zeichnet gegeniiber ILAO aus einem nicht niiher erkennbaren Grund mit 10 Takten
Verzogerung auf.
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; Match Unit Function Value Radix | Counter
=|| o= CJ MO TRIGO == 000000 000 X0 Hex '
¢ Am1TRIGT == F7|  Hex

;c Add ||Acti..) Trigger Condition ... Trigger Condition Equation Qutput Enable

=] @) | TriggerCondition0 M1 Pulse (High)

£ Window Windows: 1| Depth: | 1024 Position: a

g| - |wingow |~ 1] pepm: 1024 9

=

< | Storage Qualification: All Data

Abbildung 32: Trigger-Einstellung des ersten Logikanalysators fiir die gekoppelte Aufzeichnung

Logikanalysators auszuwéahlen und gleichfalls mit » die Aufzeichnung fiir diesen zu starten.
Wenn dieser triggert, wird iiber den Trigger-Ausgang der AXI-Monitor mitgestartet. Abb. 33
zeigt ausgewdhlte Signalwerte als Listing fiir denselben »Sample«-Bereich wie in Abb. 27. In
beiden Aufzeichnungen wechselt die LED-Ausgabe in »Sample« 118 von »01« nach »02«. In
»Sample« 121 ist im Trace-Signal die Ausgabe abgeschlossen und in »Sample« 111 der Befehl
davor. In »Sample« 113 wird das Trace-Signal »MEM _PipeRun« (MP_RUN) deaktiviert,
was vermutlich bedeuten soll, dass die Ausgabe-Pipeline anhilt. Einen Schritt spater sind die
Daten auf dem AXI-Bus giiltig. Das Giiltigkeitssignal » WVALID« wird nach Aktivierung des
Bestatigungssignals » WREADY « deaktiviert. Im Folgetakt wird das Signal » BVALID« fiir die
Schreibbestitigung fiir einen Takt giiltig und erst im néchsten Takt ist die Ausgabe eines Bytes
in ein Register fiir die LED-Anzeige abgeschlossen. Das AXI-Protokoll verlangt offenbar, dass
die Ausgabewerte bereits ab vier Takte vor der Ausgabe auf dem Bus AXI-Bus anliegen miissen
und der Prozessor noch drei Takte nach der Ausgabe auf die Bestitigung wartet.

{&] Listing - DEV:0 MyDevice0 (XC6SLX16) UNIT:0 MylLAO (ILA) {Z] Listing - DEV:0 MyDeviced (XCHSLX16) UNIT:1 MylLA1
«->| Sample |ValInstr|Trace PC| Instruct (Led MP Bun|ll «<->| Sample WDATA (WVALID| WRERDY | EVALID| Led
100 1 00000658 | 30630001 | 01 1 100 02 1] 0 a 01
101 1 0000085C | FO730020 | 01 1 101 01 0 a a 01
102 1 000006860 ( EO930020 | 01 1 102 01 1] 0 a 01
103 1 00000664 | 306000F7 | 01 1 103 01 0 a a 01
104 0 00000664 | 306000F7 | 01 1 104 F& 1] 0 a 01
105 1 00000668 | 16441803 | 01 1 105 ia] 0 a a 01
106 1 00000&6C | BCB2FFDE | 01 1 104 ia] 1] 0 a 01
107 0 00000870 ( BOOOD4000 | 01 1 107 ia] 0 a a 01
108 0 00000870 ( BOOOD4000 | 01 1 108 ia] 1] 0 a 01
109 1 00000844 ( BOOOD4000 | 01 1 1049 F7 0 a a 01
110 1 00000848 | 30600000 | 01 1 110 02 1] 0 a 01
111 1 0000084C [ E0930020 | 01 1 111 02 0 a a 01
112 0 0000084C [ E0930020 | 01 1 112 02 1] 0 a 01
113 0 0000084C [ E0930020 | 01 1] 113 02 0 a a 01
114 0 0000084C [ E0930020 | 01 ] 114 02 1 0 a 01
115 0 0000084C [ E0930020 | 01 1] 115 02 1 a a 01
116 0 0000084C [ E0930020 | 01 ] 114 02 1 0 a 01
117 0 0000084C [ E0930020 | 01 1] 117 02 1 a a 01
118 0 0000084C | E0930020 | 02 ] 118 02 1 0 a 02
119 0 0000084C [ E0930020 | 02 1] 1149 02 1 1 a 02
120 0 0000084C | E0930020 | 02 ] 120 02 1] 0 1 02
121 0 0000084C [ E0930020 | 02 1 121 02 0 a a 02
122 1 00000850 | FOE30000 | 02 1 122 ia] 1] 0 a 02
123 1 00000854 ( EO730020 | 02 1 123 ia] 0 a a 02
124 0 00000654 ( EO730020 | 02 1 124 ia] 1] 0 a 02
125 0 00000854 ( EO730020 | 02 1 125 ia] 0 a a 02
126 1 00000658 | 30630001 | 02 1 124 03 1] 0 a 02
127 1 0000085C | FO730020 | 02 1 127 02 1] a a 02

Abbildung 33: Zeitgleich aufgezeichnete Signale beider Logikanalysatoren

Das erklart zu einem grofsen Teil, wenn auch nicht vollstdndig, warum die Ausgabe so lange
dauert. Der AXI-Bus ist definitiv nicht die ideale Lsung fiir ein einfaches Rechnersystem.



